
Abstract 

The wideband MIMO PXI vector signal analyzer 
(VSA) provides up to four or more synchronized 
channels of wideband analysis capability at much 
higher speeds than oscilloscope based solutions. 
This white paper provides instructions for creating 
various solutions including:

 – Hardware and software configurations  
for different applications

 – Use of 89600 VSA software with the 
M9362A-D01 for standards based  
demodulation measurements

 – Ways to customize the system  
using modular software API’s

 – Examples for:
 – MIMO 802.11ac
 – 80+80 MHz 802.11ac
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Introduction

Increased use of wireless video and high speed wireless data 
networking drive demand for new standards, such as 802.11ac 
to enable higher throughput. Design validation engineers must 
ensure their 802.11ac designs will perform well under the most 
demanding modulation schemes, including MIMO spatial multi-
plexing configurations.

To validate 802.11ac and wideband MIMO transmitter perfor-
mance for other formats, a multichannel signal analyzer should 
be used to demodulate the multistream waveforms and measure 
EVM and other physical layer parameters.

Keysight’s wideband multichannel PXI signal analyzer solutions 
enable R&D and test engineers to validate their 802.11ac designs 
with a mixture of measurement accuracy, fast speed, flexibility 
and scalability in a small form factor.

This white paper provides detailed step by step instructions for 
configuring  
a wide bandwidth, high speed multichannel PXI VSA. It also 
explains how to understand performance tradeoffs for various 
configurations.

The MIMO VSA is typically comprised of the following modules 
(one module can accommodate up to four channels, unless other-
wise noted):

 – M9302A PXI Local Oscillator
 – M9352A PXI Hybrid Amplifier/Attenuator
 – M9362A-D01 PXIe Microwave Quad Downconverter
 – M9168C PXI Programmable Step Attenuator Module (one per 

channel)
 – M9202A PXIe 12-bit Wideband Digitizer (one per channel)

Optional configurations are also presented for an external local 
oscillator such as the MXG Signal Generator and the M9300A 
PXIe Frequency Reference. Please see the Hardware Configura-
tions section for more information.

Please also refer to the standard documentation provided for the 
M9362A-D01 PXIe Quad Downconverter:

 – Configuration Guide—Keysight literature number 5990-
9968EN

 – Datasheet—Keysight literature number 5990-6624EN
 – Startup Guide—Keysight literature number M9499-90001
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1.  
Software Installation 
Instructions

This section lists the software required to control the various modules and pro-
vides step-by-step instructions for installation. The table below provides a  
list of software and the URL where the software can be downloaded.

Step 1. Install these software packages in the order listed, following prompts 
for reboot whenever requested.

Step 2. Install licenses for the 89600 VSA software, if applicable.

Step 3. After all software has been installed, reboot the system.

Step 4. Run the Keysight connection expert to verify that all modules enumer-
ate with a VISA resource ID, and each module appears with the correct slot 
number identified on the information pane on the right when you click on each 
module.

Multichannel Wideband Streaming with PXI M9392A

Instrument Software download webpage

M9018A chassis drivers Pre-installed on M9036A embedded controller or www.
keysight.com/find/M9018A

Keysight IO Libs 16.1 1 http://www.home.keysight.com/keysight/prod-
uct.jspx?cc=US&lc=eng&ckey=1985909&nid=-
33330.977662.00&id=1985909&cmpid=zzfindiosuite

89600 VSA software http://www.keysight.com/find/vsa

M9392A drivers, v1.2 http://www.keysight.com/find/m9392a

M938x drivers: M9300A 
frequency reference required. 
Other modules are optional. 
Choose custom installer. 

http://www.keysight.com/find/m9381a

N7617B Signal Studio for 
WLAN (optional)

http://www.keysight.com/find/n7617b

M9362A-DO1 driver Included on CD that ships with M9362A-D01

M9352A driver Included on CD that ships with M9352A

M9168C driver http://www.keysight.com/find/pxiattenuator

Multichannel wideband VSA 
example

Contact your Keysight sales representative

Multichannel wideband VSA 
with external local oscillator 
example

Contact your Keysight sales representative

M9202 digitizer firmware v512 
or greater

Included with M9392A driver, v1.2. See instructions  
for checking version number at page 4.

1. At time of writing, upgrade from version 16.1 to 16.2 causes problems. Repairing VISA 
shared resources from Windows control panel should resolve the issues.

http://www.agilent.com/find/M9018A
http://www.agilent.com/find/M9018A
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.home.agilent.com/agilent/product.jspx?cc=US&lc=eng&ckey=1985909&nid=-33330.977662.00&id=1985909&cmpid=zzfindiosuite
http://www.agilent.com/find/vsa
http://www.agilent.com/find/m9392a
http://www.agilent.com/find/n7617b
http://www.agilent.com/find/pxiattenuator
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The screenshot below provides an example of a 3-channel configuration.

Potential M9202A digitizer firmware upgrades
If upgrading an existing system for multichannel, please check to ensure that 
the M9202A digitizer firmware is of version 512 or greater. Documentation 
describing the upgrade process can be found in the M9392A help system. To 
check whether a digitizer upgrade is required, run the M9392A soft front panel 
(SFP), connect to the digitizer, then select Help>About, to view the digitizer 
hardware field programmable gate array (FPGA) version number. Please follow 
the upgrade instructions if the version number is less than 512. This must be 
done for each digitizer in the configuration.
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2.  
Hardware  
Configurations

M9202A trigger setups
M9202A multichannel setups are synchronized via distribution of a trigger out 
from the master digitizer to the trigger input of all digitizers. Synchronization 
performance of the multichannel VSA is ± 2 samples of trigger uncertainty from 
acquisition to acquisition. This means the operation is not phase coherent but 
still adequate for MIMO PHY-layer EVM measurements. At full data rate, or 2 
GSa/s, ± 2 samples of trigger uncertainty equates to ± 1 ns. When using digital 
down conversion (DDC) modes, the uncertainty is based on the output sample 
rate. For example, at 100 MHz bandwidth (BW), 125 MSa/s is used, equating 
to a trigger uncertainty of ± 16 ns between channels which cannot be cali-
brated out. However, in the case of multichannel recording to disk capability, a 
technique was devised to calibrate out the timing difference between channels 
during a single acquisition, using a training sequence that is switched in at the 
beginning or end of the acquisition. Please see the Multichannel Wideband 
Streaming White Paper literature number 5991-0221EN for information on 
example software created for multichannel streaming time alignment.

There are three primary trigger modes: free run, IF magnitude, and external.  
The following table describes the conditions for which the various trigger modes 
are valid. 

Mode Single channel input Multichannel input

Free run  
(software trigger)

Auto-trigger Auto-trigger 
(unsynchronized acquisition)

IF magnitude Master input 1 Master input 1

External Master TRG 1 Master TRG 2

There is no software trigger mode synchronization for multichannel operation. 
Therefore, free run with a multichannel system will result in unsynchronized 
results. It is necessary to use either external or IF magnitude trigger modes for 
synchronized operation.

IF magnitude trigger mode 1

In IF magnitude trigger mode, the master digitizer triggers on the input signal 
into Input 1 connector. It is an envelope edge trigger, and not a level trigger.  
The master digitizer outputs a trigger output pulse of amplitude approximately  
0 to –1 V. This must be routed into all digitizers’ TRG 1 inputs including the 
master digitizer’s input.
 

External trigger mode
In external trigger mode, the master digitizer triggers on the TRG 2 input.  
The master digitizer outputs a trigger output pulse of amplitude approximately  
0 to –1 V. This must be routed into the slave digitizers’ TRG 1 inputs. It is not 
necessary to route the signal into the master digitizer’s TRG 1 input, but doing 
so will not impair performance.

1. This mode is only available when using hardware DDC. In basic digitizer mode, only ex-
ternal trigger mode is available. Refer to the appendix “M9202A HW DDC Operation” for 
details on HW and SW DDC modes.
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This setup works for both IF magnitude and external trigger modes. In both 
cases, it is necessary to set the trigger input threshold for the TRG 1 input to a 
negative voltage.

An inherent delay exists between the master and slave digitizers, as well as 
from trigger arrival at the master to signal acquisition. An effort is made in the 
89600 VSA software to correct for this. However, if the trigger timing needs to 
be precise, this will need to be manually calibrated out.

2-channel and 3-channel configurations  
with PXI local oscillator 
2-channel and 3-channel configurations using the M9362A-D01 quad down-
converter and M9202A digitizer can easily be configured in a single 18-slot PXI 
chassis. This is expected to be the most common use model for the wideband 
MIMO PXI vector signal analyzer. These configurations include:

 – M9168C attenuator module — one per channel
 – M9362A-D01 quad downconverter module
 – M9302A local oscillator module
 – M9352A IF amplifier and attenuator module
 – M9202A IF digitizer — one per channel.

If the expected signal level is less than –10 dBm, the M9168C attenuator modules  
may not be needed. Please refer to M9362A-D01 PXIe Quad Downconverter 
10 MHz to 26.5 GHz Configuration Guide (literature number 5990-9968EN) for 
details on ordering options including cable kits, model numbers, etc.

Trigger connections for a 
2-channel configuration.

 

External 
Trigger 

100 MHz 

Ref 

Master 

Splitter
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2-channel block diagram

2x2 cabling

2-channel photo

2-channel configuration with PXI local oscillator
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3-channel block diagram

3x3 cabling

3-channel photo

3-channel configuration with PXI local oscillator
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2- to 4-channel configurations with external local oscillator
There are situations when you might choose configurations with an external lo-
cal oscillator (LO), such as an MXG signal generator.

Space Considerations. To fit a 4-channel configuration in a single chassis, there 
may not be enough space for all modules, particularly if the M9168C attenuator 
modules are used for RF attenuation. In this case, removing the M9302A LO  
and using an MXG as the LO frees up space. If space is a primary concern,  
the M9170A attenuator/switch driver module supports up to two attenuator 
channels per PXI slot, controlling an external attenuator which can be placed 
close to the test fixture.

Frequency Range. The M9302A LO’s lower frequency range is 2.75 GHz,  
resulting in a minimum RF frequency of about 2.25 GHz. On the high-end, third 
harmonic mixing is used above 10 GHz. The use of a microwave MXG as LO 
enables fundamental mixing mode all the way to 26.5 GHz, avoiding the 10-12 dB 
penalty to conversion gain, and hence dynamic range, incurred from the use of 
third harmonic mixing.

A side-effect of using an external LO is the absence of 100 MHz reference  
signal to lock the M9202A digitizers via their external reference inputs. The 
M9302A LO has 100 MHz outputs that are used for this purpose. In lieu of this, 
an M9300A frequency reference module can be used to generate a clean  
100 MHz clock which can be input into the external reference inputs of the two 
M9202As. The M9300A has five 100 MHz outputs which can be routed directly 
into each of the M9202A’s reference inputs, or a single output distributed via 
tees to up to four M9202A modules. An example program is available which will 
automatically detect an M9300A installed in the chassis and set it up to output 
100 MHz from the 100 MHz “out” ports on the front panel. Using this example, 
the M9300A can also be configured to output a 10 MHz reference signal on the 
front panel, but not to accept an external reference. The example program can 
be modified as required.

The plot at 
right shows the 
conversion gain 
versus frequency. 
Conversion gain 
M9362A-D01 with 
high frequency vs  
3rd harmonic 
(M9302A) 
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2-channel external LO configuration with timing 
module and cabling 

Analog MXG as LO M9302A PXI LO

RF frequency range 10 MHz ≥ 26.5 GHz 2.25 GHz ≥ 10 GHz (fundamental)
10 GHz ≥ 26.5 GHz (3rd harmonic)

100 MHz clock for 
digitizer sync

M9300A frequency refer-
ence is recommended

Included in M9302A

Form factor Up to 4 channels VSA in 
one PXI chassis

3 channels VSA in one chassis (with 
M9168C attenuator)

The following table summarizes the tradeoffs between the PXI LO and external 
LO configurations.

4-channel external LO configuration
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4- to 8-channel configurations
Though the 89600 VSA software supports only 4-channel configurations,  
configurations of five or more channels can be created. Those configurations 
can be controlled outside of the VSA software, using the M9392A IVI driver.

When configuring a 5-8 channel PXI analyzer, please consider the following:

 – The M9362A-D01 quad downconverter makes it simple to daisy chain the  
LO from one module to the next, allowing easy 8-channel synchronous  
downconversion.

 – Attenuator modules require no synchronization, so simply add four addi-
tional M9168C attenuator modules (or use external attenuation if pre-
ferred), and a second M9352A 4-channel IF amplifier/attenuator module.

 – The M9202A digitizers will require some extra consideration. For greater 
than four channels, passive trigger distribution will not be adequate, as the 
trigger signal level may be too low for reliable triggering. An NI PXIe-6674T 
timing module may be used to distribute the triggers in this case. A single 
PXIe-6674T module should be adequate to distribute triggers to at least 
eight M9202A digitizer modules.1

 – If two or more chassis’ are required, it may be necessary to use two 
M9021A PCI Express® extender cards with a desktop controller to connect 
both chassis.

Bypass for lowband
Measuring signals below 1.2 GHz RF frequency poses potential problems. Since 
the quad downconverter is a single-conversion downconverter, there is po-
tential for LO and RF feed through to appear as interference with the IF signal. 
There is a 1 GHz low pass filter (LPF) in the M9352A IF amplifier/attenuator 
module, and further digital filtering in the 89600 VSA software, so keeping the 
RF and LO above 780 MHz will help greatly to reduce problems related to feed 
through. As a rule of thumb, if your center frequency minus half of your IF band-
width is less than 780 MHz, you may encounter IF interference problems.

One way to mitigate these problems is to bypass the downconversion chain 
entirely for frequencies in the lowband. A M9155C PXI microwave switch can 
be used between the M9168C attenuator and M9352A IF amplifier/attenuator 
module. As long as the occupied bandwidth of the RF signal to be measured fits 
within the frequency range 110 MHz to 890 MHz, you can use the direct path to 
the digitizer to capture the signal. For frequencies below 110 MHz, and between 
890 MHz and 1.2 GHz, you will still need to use the downconverter path and 
may encounter some problems with RF and IF feed through. 

1. An M9300A frequency reference module may be needed to provide a high enough 100 
MHz clock signal level for configurations with five or more channels.

Frequency bands where bypass is recommended
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3. 
Using Soft Front  
Panels to Make  
Multichannel  
Measurements

This section covers the use of soft front panels (SFP) to control the modules.

M9392A – PXI vector signal analyzer
The M9392A SFP is used primarily to configure and control a complete M9392A 
signal analyzer or a single M9202A digitizer in digitizer only mode. Generally, 
it can only be used to control one channel of M9392A or M9202A digitizer at a 
time. It is possible to launch multiple running SFP’s to control multiple channels 
concurrently. However, the multichannel trigger capability cannot be controlled 
via the SFP. The primary use of the M9392A SFP for multichannel solutions is to 
create and export configurations to be used in automation or in the 89600 VSA 
software.

The M9392A SFP help describes the process of selecting modules and creat-
ing configurations. This document introduces new types of configurations in the 
section on creating 89600 VSA hardware configurations covered in section 4. 

M9352A – PXI amplifier attenuator
The M9352A SFP can be used to set the gain on each of four channels from 8 to 
39.5 dB. The channels can be controlled independently or set to track together.

M9168C – PXI programmable step attenuator
The M9168C SFP can be used to control one M9168C attenuation value, includ-
ing reporting calibration information, so you can see the exact loss at a particu-
lar attenuation state after setting it. To control multiple M9168C modules, you 
will need to run one SFP per module.

M9302A – PXI local oscillator
The M9302A SFP can be used to set the center frequency and 10 MHz refer-
ence output state. Typically, the high-side LO is used, with an IF center fre-
quency of 500 MHz, so the LO frequency would be set to the RF center frequency 
+ 500 MHz.

At right, the SFPs for the M9168C Program-
mable Step Attenuator and the M9302A Local 
Oscillator.
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M9300A – Frequency reference 
The M9300A SFP can be used to enable the 100 MHz reference output and 
configure the 10 MHz reference input and output.
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1. The M9392A SFP control functionality may be limited when using digitizer-only mode. 
Certain controls may still be active, but serve no function when in digitizer-only mode.

4. 
Using 89600 VSA  
Software for  
Multichannel  
Measurements

This section covers configuring and using the 89600 VSA software to make  
multichannel measurements with the wideband MIMO PXI vector signal  
analyzer hardware. 

Hardware configurations
The standard M9392A configuration, documented in the M9392A SFP help 
includes:

 – M9360A, a front-end preselector/attenuator module
 – M9302A, local oscillator,
 – M9202A digitizer, and
 – Two downconverters: the M9351A for low-band, and the M9361A for  

high-band. 

This section introduces the concept of two additional types of hardware con-
figurations which are supported by the M9392A software: digitizer-only and 
simulated downconverter. It discusses the uses of digitizer-only mode, and a 
configuration using simulated modules.

As a rule of thumb, use the digitizer-only mode for bandwidths wider than  
250 MHz or for tuning each channel to different center frequencies within the  
IF bandwidth, such as when measuring 802.11ac 80+80 mode.

Digitizer only
The digitizer-only mode produces a solution with the widest bandwidth and 
widest RF frequency range. In this mode, the M9392A software controls only 
the M9202A digitizer. Frequency range is limited to the range of the IF band-
width, or 800 MHz, centered on 500 MHz. If 500 MHz is selected as the center 
frequency, with less than 250 MHz span, hardware digital downconversion 
(DDC) is automatically used. See the appendix M9202A HW DDC Operation 
at page 39 for details. In this mode, complex IQ data is stored with 32 bits per 
sample, allowing up to 128 megasamples to be captured in a single acquisition 
to the internal digitizer memory. The data is stored at a lower sample rate. For 
example, at the widest DDC frequency of 250 MHz, 500 MSa/s is used, allowing 
approximately 0.25 seconds maximum capture length for a single capture.

If a different center frequency and/or wider than 250 MHz bandwidth is chosen, 
then basic digitizer mode or a hybrid DDC mode may be used, with real data 
captured to the digitizer memory. For example, 200 MHz span centered on 700 
MHz would require at least 600 MHz of actual bandwidth (pre-DDC). In this 
mode, up to 256 megasamples can be captured in a single acquisition to the 
internal digitizer memory. The 2 GSa/s rate is always used, so the maximum 
capture time is approximately 0.125 s.

The M9202A digitizer does not have a front-end range adjustment, so any range 
adjustments made by the M9392A software or 89600 VSA software will not 
have any effect. It is necessary to control the RF and IF attenuators directly, or 
utilize a technique provided by the macro example software program covered in 
section 5.1
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Simulated downconverter
Simulated downconverter mitigates some of the challenges of operating in 
digitizer only mode, at the cost of maximum bandwidth flexibility and ability to 
tune the channels independently within the IF bandwidth. Used in conjunction 
with the macro example program, simulated downconverter capability offers a 
fairly seamless operation directly from the 89600 VSA software user interface. 
In this mode, the M9392A software controls both the digitizer and the M9302A 
LO. This means the user can set the RF center frequency directly on the 89600 
VSA user interface, and the M9392A drivers will set the LO and IF frequencies 
automatically.

Attenuators will still need to be controlled from outside of the VSA software, 
and amplitude values returned will not be calibrated. Both of these will be 
addressed by the macro example program. Because the attenuator control is 
outside of the VSA software, the range settings made on the VSA software 
will not have any effect. Additionally, the maximum span will be 250 MHz, the 
same as the M9392A hardware limits. If wider span is required, you must use 
digitizer-only mode.

Creating IVI configuration store entries
A prerequisite to using the M9392A software is to create an IVI configuration 
store entry for each channel. This is accomplished via the M9392A SFP. After 
launching the M9392A SFP, select hardware via the dialog box. Any modules 
recognized by the M9392A software will appear. For wideband MIMO PXI VSA 
configurations, these will be the M9202A digitizers and possibly the M9302A 
LO. For synchronized multichannel operation, you will need to designate one of 
your digitizers as master, and the remaining as slaves. It helps to pick a con-
vention, such as master on left, slave 1 in the next slot to the right, slave 2 to 
the right of slave 1, etc. Follow the same convention for M9168C attenuator 
modules.

Configuring the digitizer-only mode
Step 1. Use the Keysight Connection Expert tool to identify the M9202A digi-
tizer in the left-most slot.

Note the VISA resource ID  
(for example, PXI17::12::0::INSTR).
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Step 2. Start the M9392A SFP, and choose only the M9202A digitizer with this 
resource ID.

Step 3. Press connect, and wait for hardware initialization to complete.  
Choose File>Save Connection.

Step 4. In the dialog box, give the configuration a recognizable name, avoiding 
spaces and underscore (_) characters. Enter a description in the description 
field, and be sure to check Export to Keysight 89600 VSA before pressing the 
Save button.
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Step 5. Choose the File>Connect menu, and connect to the first slave digitizer. 

Step 6. Save a configuration for this digitizer, repeating for all channels in your 
configuration.

Configuring the simulated downconverter mode
Step 1. Use the Keysight Connection Expert tool to identify the M9202A digi-
tizer in the left-most slot.

Step 2. Start the M9392A SFP, and choose only the M9202A digitizer with this 
resource ID.

Step 3. Add to this the M9302A LO module.

Step 4. Add entries manually in the selected instrument: field for a simulated 
M9360A front-end module and M9361A microwave attenuator module. These 
simulated entries should look like this: SIM::M9360A;SIM::M9361A. Shown 
below, a complete master selection.

Type simulated modules in selected instrument field.

Note the VISA resource ID  
(for example, PXI17::12::0::INSTR).
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Step 5. Click connect, and wait for hardware initialization to complete.  
Choose File>Save Connection.

Step 6. In the dialog that appears, give the configuration a recognizable name, 
avoiding spaces and underscore (_) characters. Enter a description in the 
description field, and 
be sure to check the 
Export to Keysight 
89600 VSA checkbox 
before pressing the 
Save button.

Step 7. Choose the File>Connect… menu, and connect to the first slave 
digitizer, with simulated LO, downconverter, and front-end module. The  
simulated LO entry is 
similar to the previ-
ous simulated entries: 
SIM::M9302A. The figure 
at right shows a slave 
configuration selection.

Step 8. Save the  
instrument connection 
as you did for the master 
connection, and repeat 
for all slave channels.



20

Creating an 89600 VSA hardware configuration
The next step will be to create the hardware configuration in the 89600 VSA 
software. If the VSA software is already running, you will need to restart it or  
re-discover hardware now. This will allow it to recognize the new IVI  
configuration store entries that you exported in the previous step.

Step 1. On the Utilities> 
Hardware dialog in the VSA 
software, click on the dis-
covered instruments tab. The 
configurations you just added 
will be present under the TCPIP 
tree element.

1. It is important that the master channel be associated with the topmost entry for synchro-
nized operation.

Step 2. Switch back to the configurations tab, and create a new configuration 
by pressing the button with the green ‘+’ symbol.

Step 3. Add one Keysight M9392A analyzer connection per channel to the 
configuration box by clicking the right-arrow button. Select the master channel 
configuration — either digitizer-only or simulated downconverter you created 
for the top-most entry in the configuration box from the drop-down list labeled 
‘ADC.’ Repeat this for the slave channels.1
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Step 4. Now you are ready to start using your hardware. Give the configuration 
a name and click OK.

Step 5. On the hardware dialog, choose the newly created configuration from the 
‘Current Analyzer Configuration’ listbox, and wait for the hardware to initialize.

Adjusting trigger delay and channel to channel skew
Trigger delay for all channels can be adjusted by using the delay setting on 
the Input>Trigger dialog. To adjust the channel to channel skew between the 
master and all slave channels, use Input>Extensions: SlaveTriggerSkew. See the 
following section for details on new trigger delays and slave trigger level input 
extensions at page 25.

By default, after selecting a multichannel PXI VSA hardware configura-
tion, only 1 input channel will be enabled. To enable more channels, use the 
Input>Channels menu, or load a multichannel configuration.

Setting the number of channels
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In digitizer-only mode, the spectrum may be inverted, depending on whether 
you are using high-side or low-side LO. If you are using high-side LO, you 
should use the VSA software’s mirror spectrum capability. This can be accom-
plished in several ways:

 – The demodulation properties for a given standard usually have a mirror  
spectrum option for 802.11n/ac demodulation.

 – The User Correction>Frequency Converter capability allows setting spectrum  
to inverted. This is also one way to enable the 89600 VSA software to dis-
play the actual RF center frequency, rather than the IF frequency.

 – The simulated downconverter technique provides another way to accom-
plish this, as discussed below. 

Once the trigger levels and other settings are complete, start making mea-
surements. Set your center frequency to the IF center frequency (nominally 
500 MHz for DDC operation in digitizer-only mode) and your bandwidth. It 
is possible to set different IF center frequencies for synchronous analysis of 
signals on different channels, such as 80+80 MHz bandwidth. An example of 
this is covered in Section 8. With a 500 MHz center frequency, a span of up to 
800 MHz (781 MHz in 802.11n/ac demodulation mode) is settable. If a higher or 
lower center frequency is chosen, the span will be limited. 

In simulated downconverter mode, while it is possible to set different RF center 
frequencies for each channel, only the setting on the master channel (channel 1)  
will have any effect. With version 14.2 of the 89600 VSA software, the spans 
must be set to the same value for all channels.
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A dialog will appear with the addresses of M9168C attenuator modules and 
the M9352A IF Amp/Atten module. It also indicates the status of the hardware, 
including attenuator and gain settings of the hardware. This dialog will minimize 
after a few seconds.

It is important to set the number of channels before starting the MultiChan-
WidebandVSA macro. If you need to change the number of input channels while 
the macro is running, change the number of input channels and then restart 
the macro program by closing its window, then selecting the macro again and 
clicking run.

An example program was created for use with the VSA which allows seamless 
operation through the VSA software user interface. Copy the entire directory 
containing the MultiChanWidebandVSA to the user’s VSA Software Macros di-
rectory, which is found in <User home>\My Documents\Keysight\89600B VSA\
Macros.

You will need to restart the VSA software for the new macro to be recognized.  
After restarting the 89600 VSA software, run the macro by selecting Utilities> 
Macros on the VSA software menu. Select MultiChanWidebandVSA and click run.

5. 
The VSA Macro 
Example Program 
for Multichannel 
Measurements
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The macro program runs in the background, and performs several functions:

 – Changing the input range on any channel in the VSA software will result in 
the attenuator and IF gain settings to change accordingly. The algorithm is 
simple: above –10 dBm input range, 1 dB of RF attenuation is added per dB 
above –10 dBm. Below –10 dBm input range, 1 dB of IF gain is added per 
dB below –10 dBm. The Input>Extensions IF offset and force RF front end 
attenuation settings can be used to adjust this algorithm if desired.

 – Coarse amplitude correction is performed based on the input range setting 
by setting the VSA software user correction gain to compensate for the RF 
and IF attenuator loss.

 – The auto range button can be pressed to perform input auto ranging. Both 
channels will be auto ranged to the same level. The algorithm used is a 
search for input overrange, and requires that an acquisition time is set that 
guarantees signal presence on every acquisition. It is not recommended to 
use IF magnitude trigger mode for this auto range, as the signal level could 
fall below the trigger threshold during the search. The auto range capability 
in the macro user interface should be used instead of the auto range button 
on the 89600 VSA software toolbar.
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Trigger delay for all channels can be adjusted by using the delay setting on the 
Input>Trigger dialog. To adjust the channel to channel skew between the master 
and all slave channels, a new parameter has been added to Input>Extensions: 
SlaveTriggerSkew.

Enter a number in seconds to move the slave trigger point relative to the master 
digitizer, as shown on below.

6. 
New Trigger Delay  
and Slave Trigger Level 
Input Extensions
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The trigger level setting on the Input>Trigger dialog will set the trigger input 
threshold for the master digitizer’s input, either on the signal input, or on the 
trigger input (TRG 1 for single channel, TRG 2 for multichannel). The default 
slave sync trigger level will be set to –0.5 V. This will need to be changed if 
more than 2 channels are used, or if a different trigger distribution mecha-
nism is used. For example, using a timing module with default output levels 
will require setting to a 0.5 V trigger input level. Using a TEE for up to 4 chan-
nels will require setting a trigger input threshold between –0.1 to –0.25 V. To 
set the slave sync trigger threshold, set the SlaveTriggerLevel parameter on 
Input>Extensions, as depicted in the diagram below. 
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This section describes an example created for multichannel wideband measure-
ments of MIMO 802.11ac. The example uses three N5182A MXG vector signal 
generators (VSG) with synchronization cables, and Signal Studio N7617B WLAN 
signal generation software to generate a 3-stream 80 MHz bandwidth 802.11ac 
waveform with 256-QAM modulation format. 

The signal is generated by Signal Studio, 
setting up the three MXG’s in an Mx3 MIMO 
802.11ac generation with 3 spatial streams.

7. 
MIMO 802.11 ac  
Example
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For best operation, the MXG’s should have had an IQ skew calibration and 
channel flatness calibration performed. Please see the MXG MIMO optimization 
appendix for detailed instructions.

To make the measurement using the 89600 VSA software, perform the follow-
ing steps:

 – Enable three input channels.
 – Enable external or IF magnitude trigger for proper synchronization of the 

analyzer channels.
 – Switch the 89600 VSA software to the 802.11n/ac demodulation mode.
 – Set to 80 MHz bandwidth.
 – Set the center frequency to your RF center frequency if using simulation 

mode, or to the IF frequency (nominally 500 MHz).
 – Set the span to 80 MHz or greater.
 – Adjust the input range until the overload indicator appears, and then 

increase range until the overload indicator goes away. This will ensure the 
signal level is very close to the full scale input of the digitizer for optimal 
signal to noise and therefore optimal error vector magnitude (EVM) perfor-
mance.

The results should look something like this:
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Use the digitizer-only mode to measure 80+80, and independently tune the IF 
center frequency on two input channels of the PXI vector signal analyzer (VSA). 
First, set up the hardware with two N5182A MXG VSG’s in a MIMO configura-
tion. The signal can be analyzed as a single-channel 160 MHz bandwidth input, 
if the channels are contiguous, as shown below. Alternatively, each output  
can be connected to a different channel and analyzed using the 89600 VSA’s 
80+80 mode. The following example shows 80+80 mode.

8. 
80+80 MHz  
802.11ac Example

Generate the waveform using Signal Studio for WLAN N7617B, using the  
80+80 mode, and specifying the channel spacing in the user interface.  
Optimize the MXG signal generators by performing IQ skew and channel flatness  
correction. See the appendix on MXG MIMO optimization for instructions. After 
playing the waveform, set up the 89600 VSA software.

 – Select digitizer-only hardware.
 – Enable two input channels.
 – Enable the WLAN 802.11n/ac demodulation mode.
 – Select 80+80 MHz mode from the demodulation properties.
 – Ensure that trigger mode is external or IF magnitude for proper capture 

synchronization.
 – Set LO frequency (this can be done manually using the M9302A SFP).
 – Set the RF attenuators and IF gain (using the M9168C SFP and M9352A 

SFP).
 – Set your IF center frequency on each channel to an appropriate offset.
 – Set the span to 80 MHz.
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If channels are spaced 160 MHz apart, the LO can be set to the mid point be-
tween the two channels, plus 500 MHz. IF center frequencies can be set  
to 420 MHz and 580 MHz. Remember to enable spectrum mirroring in the 
802.11n/ac demodulation properties dialog. 

The results should look something like the following. There will be two streams 
displayed, and the available data is organized differently than for single channel 
SISO or from multi-channel MIMO modes. See the Keysight 89600 VSA soft-
ware documentation for details on data display for this mode.
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To create your own, press the new button and configure the limit parameters. 
For SEM, use relative to reference level mode for best performance. You will 
need to adjust the reference level to be at the peak amplitude of the signal.

At right, is an example of the limit definition for an 80 MHz bandwidth signal 
with a span of 250 MHz.

The limit markers in the 89600 VSA software can be used to measure spectral 
mask on a spectrum display or on a channel frequency response display. Pre-
configured limits files are available for various channel bandwidths, or you can 
create your own. To import existing files, use the Utilities>Limit Tests menu, and 
press the recall button. You can import .lim files to create a suite of limits that 
are available for use with traces on the VSA software display.

9. 
Making Spectral  
Emission Mask (SEM)  
and Sub-Carrier  
Flatness  
Measurements
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After application of the limit line on the spectrum trace, the limit line appears 
on the display and the output window will include a pass/fail result. These re-
sults can be queried in the 89600 VSA software API. See the screenshot, below.

Channel flatness limits can be applied in a similar way. In this case, two limit 
lines are used instead of one.
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The following API are documented with their respective products. This section 
gives an overview of functions needed for automating the wideband MIMO  
PXI VSA.

89600 VSA software
89600 VSA software has several API interfaces including SCPI, .NET and COM. 
The 89600 VSA API documentation contains details and examples for automating  
measurements and querying results with APIs.

A connection can be made to an existing VSA session , or launch a new session. 
Complete control over the VSA software can be exercised, including sweep 
control, querying measurement results, setting user corrections, etc.

M9392A
M9392A software is used to control the digitizers and in simulation mode, the 
M9302A LO as well. Because the M9392A API documentation contains exam-
ples and details of this API only the commands needed for control of multichan-
nel hardware will be covered below.

10. 
API Programming  
Instructions
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New commands
The following new methods and properties are available for multichannel setups 
and are documented in the M9392A API.

The AGM9392_ATTR_CURRENT_TRIGGER_SOURCE_Attribute has two new 
settings. These should be used for the master digitizer when in IF magnitude 
or external trigger modes. The slave digitizers should be set to external trigger 
mode.

When setting up for each acquisition, it is important to arm the slave modules 
before the master digitizer, so that when the master digitizer triggers, the slave 
modules are ready to receive the trigger generated by the master digitizer. 
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MD1
The MD1 driver is used to control many Keysight digitizers, including the 
M9202A. This is the underlying driver used by the M9392A API to control the 
digitizer. You should not need to control the digitizer directly using this driver, 
but you may in some circumstances want to access functionality that is not 
exposed by the M9392A API.

M9302A
The M9302A control is very straightforward. You will primarily be setting the 
center frequency of the LO when controlling the system via digitizer-only mode. 
To do this, you’ll need to call two methods:

 – AgM9302 _ ConfigureBandSwitchFrequency(uint32 _ t Vi, 
double BandSwitchFrequency). This method is used for an internal 
frequency band setting. We typically set this to 5.0e9.
 – AgM9302 _ Configure(uint32 _ t Vi, double Frequency, 
int16 _ t Enabled). This method is used to set the actual center fre-
quency of the LO. Keep in mind that this is not the input RF center fre-
quency, but the LO frequency, which typically should be 500 MHz above 
your RF center frequency, or one third of this frequency if operating in third 
harmonic mode (above 10 GHz). 

M9168C
The M9168C API is also very straightforward. The attenuation is simply set to 
the desired value in dB.

ViStatus AgM9168x _ SetAttenuation(
 ViSession Vi,
 ViInt32 Attenuation
);
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M9352A
The M9352A has an interface for setting up the attenuator state at a register 
level, but there is a gain property that makes this much easier. The gain can be 
set from 8 dB to 39.5 dB. The module has a fixed gain amplifier and that setting 
is adjusting a variable attenuator.

The following is set as a property or attribute. There is not a dedicated function 
to set this.

#define AGAMPATTEN _ ATTR _ GAIN 1150006

ViStatus AgAmpAtten _ GetAttributeViReal64(
 ViSession Vi,
 ViConstString RepCapIdentifier,
 ViAttr AttributeID,
 ViReal64* AttributeValue
);

ViStatus AgAmpAtten _ SetAttributeViReal64(
 ViSession Vi,
 ViAttr AttributeID,
 ViReal64* AttributeValue
);

M9362A-D01
The M9362A-D01 has no settable parameters and nothing that can be queried, 
so there is no API for this module.

M9300A
Upon initialization, the default state of the M9300A will have all of its 100 MHz 
reference outputs enabled and the 10 MHz reference input enabled. To enable 
the 10 MHz reference output, use the following property/method (C# example):

driver.ReferenceBase.Ref10MHzOutEnabled = true;
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Characteristic performance

VSA Option B7Z 802.11n, Option BHJ 802.11ac

Wideband MIMO PXI VSA 
Measurement inputs: 1,2,3 or 4 channels

Signal playback

Result length Auto-detect or manually adjustable.

Capture length Dependent on span, center frequency. 100 MHz span: 8.4 ms

Accuracy Input at average –15 dBm on all input channels. RMS averaging with average count = 20. At least 16 
data symbols analyzed in each burst. Analyzer span set to default.

Signal BW

20 MHz  
(31.25 MHz span)

40 MHz  
(62.5 MHz span)

80 MHz  
(125 MHz span)

Equalizer training = channel 
estimated sequence only

2.4 GHz center freq –43 dB –45 dB –44 dB

5.8 GHz center freq –43 dB –43 dB –42 dB

Equalizer training = channel 
estimated sequence & data

2.4 GHz center freq –46 dB –48 dB –46 dB

5.8 GHz center freq –45 dB –46 dB –45 dB

Frequency lock range ± 2 x subcarrier spacing = ± 625 kHz at default subcarrier spacing

Sample data for 160 MHz (signal generated by N5182B MXG)



38

Dynamic range
This data was measured by terminating the input of an M9168C attenuator set 
to 0 dB attenuation, through the M9362A-D01 quad downconverter, and the 
M9352A IF attenuator/amplifier module, and finally into M9202A digitizer with 
DDC enabled. The noise floor was measured in a 10 kHz span and the gain of 
the input chain used to calculate signal to noise based on maximum input signal 
at P0.1 dB level of the downconverter.

At minimum gain on M9352A attenuator module (assume max input signal of 
–10 dBm):
 Noise floor: –136.7 dBm/Hz
 S/N ratio: 135 dB

At maximum gain on M9352A attenuator module (assume max input signal of 
–40 dBm):
 Noise floor: –115.5 dBm/Hz
 S/N ratio: 107 dB

Sample measurement for 2x2 including SEM mask 
limits and subcarrier flatness limits.
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EVM versus input level was measured, to provide some insight into optimal 
settings for RF and IF attenuation. For these measurements, a 40 MHz 802.11n 
signal was measured at 2.4 GHz and 5.8 GHz. Signal level input to the M9168C 
module was kept at –2 dBm average power, and RF attenuation was adjusted to 
measure the effect of input level on the M9362A-D01 quad downconverter per-
formance. At each power step, the gain of the M9352A IF amplifier/attenuator 
module was adjusted to obtain optimal input level at the input of the M9202A 
IF digitizer. Channel estimation on preamble only was used. The optimal EVM 
was achieved with average input power of the 802.11n signal at the input of the 
downconverter between approximately –19 and –15 dBm.

TOI
TOI was measured using two N5182A MXG signal generators with a 10 dB 
attenuator on the output of each, into a precision 2-resistor power splitter. 
The signal generators were set to a fixed output power and the M9168C was 
adjusted to measure TOI at various mixer drive levels. The M9352A IF amplifier/
attenuator module was adjusted at each level to achieve optimal signal level at 
the input of the M9202A digitizer.

Input level of each tone  
at downconverter (dBm)

TOI (dBm)

–28 28.9

–18 25.5

–15 22.1

–13 19.7

Two tones, at 2.41 GHz and 2.39 GHz  
were used for this measurement.

EVM vs input power
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Crosstalk
Crosstalk was measured by terminating the input of one channel at the input 
of the M9168C, and applying a CW signal to the input of a second channel. 
The signal levels were measured using the 89600 VSA software, and isolation 
between channels measured to be better than –80 dBc.
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LO feedthrough
LO feedthrough was measured using a E4440A Performance Spectrum Ana-
lyzer (PSA) signal analyzer measuring the output of the M9352A IF amplifier/
attenuator module, with the input of the M9168C RF attenuator terminated. An 
N5182A MXG was used to drive the LO input of the M9362A-D01 quad down-
converter at different signal levels and the power of the LO at the output of 
the M9352A was measured. The feedthrough below 1 GHz can be mitigated by 
bypassing the downconverter in this frequency range.

LO frequency LO feedthrough (dBc)

5.5 GHz < –80

4.0 GHz < –80

3.0 GHz < –75

2.75 GHz < –80

2.0 GHz < –80

1.5 GHz < –80

1.1 GHz < –60 + M9352A gain

1.0 GHz < –40 + M9352A gain

500 MHz < –40 + M9352A gain

100 MHz < –40 + M9352A gain

10 MHz < –35 + M9352A gain

RF feedthrough
RF Feedthrough was measured for a 200 MHz CW tone input to M9168C  
attenuator input with various LO frequencies.

LO frequency (MHz) Feedthrough (dBc)

400 –30 + M9352A Gain

500 –15 + M9352A Gain

600 0 + M9352A Gain

Timing synchronization
± 2 samples of trigger uncertainty from acquisition to acquisition, at output 
sample rate if using hardware DDC.
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M9202A hardware DDC operation
The M9202A digitizer used with the M9392A software, takes advantage of a 
hardware digital down conversion (DDC) in the digitizer’s FPGA under certain 
conditions. This DDC allows for data reduction, which results in faster through-
put and reduced capture sizes, which increases the maximum length of a cap-
ture by more efficiently utilizing the digitizer’s memory. It also improves signal 
to noise ratio, resulting in improved residual EVM, among other effects. The 
hardware DDC is enabled under a limited set of conditions. When the hardware 
DDC is not enabled, a software DDC is used instead, which is less efficient be-
cause captures in this mode are stored to digitizer memory as real, full sample 
rate data, and the software DDC is performed in the controller by the M9392A 
driver. This appendix describes the conditions under which hardware DDC is 
available for both complete M9392A (including simulated LO/downconverter 
modes), and digitizer-only modes.

Complete M9392A including simulated LO/downconverter
In this mode, hardware DDC is almost always used, as the IF center frequen-
cies and bandwidth are chosen by the M9392A driver to ensure hardware 
DDC operation. The only exception is through the use of an IF offset hint. The 
hint usage is documented in the M9392A software, and is available through 
the M9392A IVI API as well as exposed in the input extensions interface in the 
89600 VSA software. When an IF offset (other than 0) is used, you may encoun-
ter a “mixed mode DDC,” in which the following conditions apply:

 – HW DDC decimates down to 2x the final bandwidth and sample rate
 – The M9392A driver applies a frequency shift to the final IF offset
 – SW DDC in the M9392A driver does a final decimation by a factor of 2

Note that pure hardware DDC may still be available under a specific set of  
conditions, if the entire IF span is contained between 375 and 625 MHz, and 
with a valid IF center frequency as defined below.

11. 
Appendix

Bandwidth (MHz) Valid IF center frequency for hardware DDC (MHz)

250 500

125 500

62.5 437.5, 500, 562.5 (previous row ± 62.5)

31.25 406.25, 437.5, 468.75, 500, 531.25, 562.5, 593.75 
(previous row ± 31.25)

15.625 (previous row ± 15.625)

Etc. (7.8125, 3.90625,  
1.953125, …)

Etc. (previous row ± bandwidth)
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In some cases, hardware DDC cannot be used. Conditions that trigger this 
include:

 – IF bandwidth greater than 250 MHz
 – IF center frequency outside the range of 375 to 625 MHz
 – IF center frequency within 375 to 625 MHz, but the IF bandwidth causes 

part of the IF signal to fall outside the 375 to 625 MHz range

If one of these conditions holds true, software DDC is used exclusively and all 
decimation and frequency shifting is performed by the M9392A driver.

Digitizer-only mode
In digitizer-only mode, it is possible for any of the three operation modes 
described above to occur. Because the IF center frequency can be set directly 
in the 89600 VSA software or through the M9392A API, it is much more likely 
for either the mixed mode DDC or software DDC modes to be used. The same 
rules from the previous section apply, but the IF offset hint is not needed to set 
the IF center frequency. All other settings will either utilize mixed mode DDC 
or software DDC, depending on whether the IF span is fully contained with the 
375-625 MHz range.

Additional notes
IF (video) triggering only operates in pure hardware DDC mode. The M9392A 
driver will automatically switch to external trigger if video trigger is enabled and 
the digitizer is operating in mixed mode DDC or software DDC modes.

The maximum acquisition time for a given bandwidth will be different in each of 
the three DDC modes. The nominal trigger delay may be different in each of the 
three DDC modes.

MXG MIMO optimization

MXG I/Q skew and channel correction

New calibrations were introduced in version A.01.60 of the MXG firmware to 
compensate for the I/Q skew of the internal modulator and provide magnitude 
and phase corrections across the 100 MHz modulation bandwidth over all RF
frequencies. These calibrations were performed at Keysight for all instruments 
shipped with version A.01.60 or later and do not need to be repeated. Newly an-
nounced EXGs and MXGs (model #s N5171B/72B & N5181B/82B) have IQ skew 
correction from the factory, so only the channel flatness correction needs to be 
considered. Older MXGs can get the benefit of these calibrations by upgrading 
the firmware and performing the calibrations. An N9020A MXA or N9030A PXA 
signal analyzer is required to perform the I/Q skew calibration.

The I/Q skew correction is highly recommended for improving the EVM perfor-
mance of 802.11ac signals, especially for 80 MHz bandwidth. With this cor-
rection, typical EVM should be –45 dB or better (–46 dB = 0.5%). The channel 
correction has less impact, and it is turned off by default because it slows down 
the switching speed of the instrument.
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To check if your MXG has these calibrations, press these keys on the front panel 
of the MXG: I/Q, More, Int Channel Correction. The display will tell you if the I/Q 
skew calibration needs to be performed. To perform the calibrations, connect 
an MXA or PXA signal analyzer to the MXG with LAN or GPIB and RF connec-
tions. Follow the instructions on the front panel. LAN connections need to be 
made using a networked LAN, not using direct connection or a local hub.

The Int Channel Correction can be turned on from this menu. Note that this 
must be done after the waveform is downloaded into the MXG, since a preset is 
performed during the download process and that turns off the channel cor-
rection. For 80+80 MHz signal generation, turning on the channel correction 
will cause the MXGs to display the WATRG annunciator, indicating that the box 
is waiting for a trigger to restart waveform playback. To manually trigger the 
waveforms in the MXGs, from the master MXG press these keys: Mode, Dual 
ARB, Trigger Source (Bus), Trigger Source (Bus), Trigger Key.

Press the trigger hard key on the master MXG to restart the waveform play-
back. If the latest version of Signal Studio is used, internal channel flatness 
corrections  
can be enabled from the IQ section of the instrument controls pane.

I/Q calibration and adjustments
The following steps may be performed on an ESG, MXG, or PSG signal genera-
tor to improve the EVM of the output signal.

a. Run a DC calibration to improve the DC offset, gain and quadrature error of 
the I/Q modulator. This applies to a single frequency. Changing any settings 
after the calibration except for I/Q adjustments will void the calibration and 
the instrument will revert to the factory calibration data. Press these keys: 
I/Q, I/Q Calibration, DC, Execute Cal.

b.  Calibrate the I/Q offset, gain, and quadrature errors over a user-defined fre-
quency span. Press these keys: I/Q, I/Q Calibration, User. Set the start/stop 
frequencies, then execute calibration. You can also perform a full calibration 
over the full frequency span of the signal generator, which takes longer.

c.  Use the I/Q adjustments menu to correct for specific I/Q errors. You can 
analyze the signal using the 89601B VSA software to see the amounts of the 
I/Q quadrature error, gain imbalance, or I/Q skew and use the information to 
correct for these errors in the signal generator.

For more information on int channel correction for EXG and N5182B signal  
generators, please see the Keysight X-Series Signal Generators Users Guides, 
page 106 (literature number N5180-90056).

For more information on int channel correction/IQ skew for N9182A signal 
generators, please see MXG Signal Generators User Guide, page 111, (literature 
number N5180-90003).
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